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Terms of Use 

Information in this document is subject to change without notice and does not 
represent a commitment on the part of NETCON Technologies Inc. The 
software, which includes information contained in any databases, described in 
this document is furnished under a license agreement or nondisclosure 
agreement and may be used or copied only in accordance with the terms of the 
agreement. It is against the law to copy the software on any medium except as 
specifically allowed in the license or nondisclosure agreement. No part of this 
manual may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, including photocopying and recording, for any 
purpose without the express written permission of NETCON Technologies Inc. 

This software program and associated documentation are provided in an “as is” 
condition. In no event shall NETCON Technologies Inc., its employees, 
directors or agents be liable for any loss or damage whatsoever (including, but 
not limited to, damages for loss of business profits, business interruption, loss of 
business information, or other monetary loss) arising out of the use of or the 
inability to use this software. By installing this software on your computer 
system you acknowledge that you have read and understood these terms and that 
you accept them. 

© 1994 - 2007 NETCON Technologies Inc. All rights reserved.  

Printed in Canada 

FirstPAGE is a trademark of NETCON Technologies Inc. Other brand and 
product names are trademarks, or registered trademarks, of their respective 
holders. 
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C h a p t e r  O n e  

ABOUT CIMPAGER 

This chapter introduces CIMPager, including an introduction to not 
only the product itself, but the documentation package as well. This 
manual contains an overview of the product, detailed installation 
instructions, and administration user instructions. 
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Getting Started 

This manual contains procedural and conceptual information about 
CIMPager. It was written to help administrators install and maintain 
CIMPager and also to provide them with a general knowledge of how 
the product works. 

While it is not required that the user have any prior programming or 
wireless communications experience, the user should understand basic 
Windows concepts.  The CIMPager application is used to maintain alarm 
entries and distribution lists.  For more information about CIMPager, see 
Chapter 5: Using CIMPager. 

While this guide exists primarily as a user guide, it also contains detailed 
information regarding the installation of CIMPager. The installation 
section takes you through installation procedures, setup instructions and 
general requirements. For more information about software installation 
and setup, see Chapter 2: Installing CIMPager. 

The terminology used in this manual is defined in the glossary at the end 
of this manual. 
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Documentation Conventions 

This document contains the following documentation conventions to help 
you navigate through the manual and obtain a better understanding of the 
material. 

� Notes contain tips or reminders about procedural and 
conceptual information within the manual. 

 

� Cross references provide you with a link to further 
information about the section of the document you are 
currently reading. 

 

Using the Toolbar 

The CIMPager toolbar allows you to quickly access menu items at the 
click of a button. The toolbar is located below the menu at the top of the 
screen. 

Toolbar 

 

 

•  - Allows you to exit the application. 

•  - Saves changes to the FPAGECIM.CSV file 

•  - Allows you to add a new Alarm Pager Entry or 
Distribution List 

•   - Allows you to delete an Alarm Pager Entry or Distribution 
List 

• - Allows you to modify an Alarm Pager Entry or Distribution 
List 
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•  - Allows you to refresh the list of configured alarms 

•  - Allows you to set the location of your FirstPAGE Server, 
Port, and the time interval between pages. 
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CIMPager Features   

• Deferred/Scheduled Messaging 

• Support for Additional Modules: 

� FirstPAGE Web Client: A software bundle that contains Web 
Client 

� Web Client enables a user to send messages from anywhere to 
almost any wireless device. Whether you are using pagers, 
digital cellular phones/PCS phones, or hand-helds; virtually any 
device with wireless messaging capabilities is within reach from 
your browser. 

� Pager Administration System: A centralized client/server pager 
management system. This module allows you to setup and 
configure your pagers in a one spot. No more having to setup 
your pagers in FirstPAGE Server and then in your Zetron Paging 
Terminal. 

• Included Shift Scheduler 

• FirstPAGE Administrator to control the paging system and maintain 
the Provider and Pager databases 

• Support for pager ids greater than 9 digits 

• Import/Export pager configuration to and from a CSV file. 

• Escalation Parameters are now configured in seconds rather than 
minutes. 

• Allow sending of pages to a distribution list (see example 
doc\distribution.bcl) 

• FirstPAGE Client allows users to configure their own distribution 
lists 

Pager Administrator allows users to add private users to the user’s 
list.  Private users cannot be seen in FirstPAGE Client but are 
available to send alarms to. 
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How It Works 

CIMPager allows the routing of your process alarms to any standard 
Alphanumeric Pager, phone, database destination, or email. 

Use CIMPager Configuration to configure pager actions for alarms 
generated by custom software, or to modify pagers for CIMPLICITY 
system events or product options. 
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C h a p t e r  T w o  

Installing CIMPager 

This chapter describes the CIMPager installation and setup process. It 
begins with general installation requirements and concludes with 
procedural information about installing the server software. 
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System Checks and Requirements 

Before beginning the installation, it is important to determine the 
hardware and software requirements necessary for CIMPager.   The 
following list contains important decisions that must be considered 
before the software is installed: 

Installation Considerations 

System Requirements  

• One of: 

Microsoft Win2K (SP4) 

Microsoft Win2K3 

Microsoft XP (SP1a) 

• Applications 

CIMPLICITY HMI 4.01 SP10, 5.0x, 5.5, 6.0, 6.1 or 6.2 

Adobe Reader 

• Disk Space 

120 MB 

• Display 

800x600 

• Drivers 

TCP/IP 

MDAC v2.7 + sp1  

MDAC V2.7 + sp1 (for W2K) 

• RAM 

128 MB 

 

Additional Requirements  

• Determine which disk drive/directory the CIMPager software will 
reside on.  

• Determine if you are installing CIMPager for the first time or if you 
are upgrading from an existing version.  
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Installing CIMPager for the First Time 

This includes users upgrading from CIMPLICITY HMI 4.x, 
CIMPLICITY HMI 5, CIMPLICITY HMI 5.5, CIMPLICITY HMI 6.0, 
CIMPLICITY 6.1 or Proficy CIMPLICITY 6.2 who have never installed 
the pager option. For those users who have installed Pager previously, 
but have never used it, simply delete the "pager" directory from your 
CIMPLICITY root directory and proceed as stated below. 

There are 2 types of CIMPager installations: the Server or the 
Administrator versions.  With the Server version, FirstPAGE Server may 
optionally be installed on the same server. 



NETCON Technologies 

14 

Local Server Installation 

The Local Server installation is for sites that only have 1 server running 
CIMPLICITY. If this is the case, the CIMPLICITY server can also act as 
the paging server which will require access to a commercial paging 
service provider and/or an in-house paging terminal. There are various 
connection methods including modem, Internet (SNPP), and direct 
connection (serial). 

 

CIMPLICITY Pager - Local Server Install

CIMPLICITY HMI Server
CIMPLICITY Pager Server
FirstPAGE Server - Local

Modem

In-House System

Commercial Carrier

 
 

To install the Local Server version select the "Pager" option from the 
CIMPLICITY main installation, then choose the “CIMPager – Server” 
install with Local FirstPAGE Server when prompted. After everything is 
installed, it is best to configure your paging server first (i.e. add your 
pagers), then configure CIMPager. Detailed instructions on how to 
configure your FirstPAGE Paging Server can be found in the 
"FirstPAGE Administrator User Guide". 
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Remote Server Install 

The Remote Server installation is for sites that have multiple 
CIMPLICITY servers and require a central paging server. This requires 
the installation of CIMPager – Server on each of the CIMPLICITY 
servers and the installation of FirstPAGE Server on a designated server 
that will have access to a commercial paging service provider and/or an 
in-house paging system.  

CIMPLICITY Pager - Remote Server  Install

FirstPAGE Server

Modem

In-House System

CIMPLICITY HMI Server
CIMPLICITY Pager - Server

CIMPLICITY HMI Server
CIMPLICITY Pager - Server

CIMPLICITY HMI Server
CIMPLICITY Pager - Server

Commercial Carrier

 
 

To install the Remote Server version on your CIMPLICITY Servers 
select the "Pager" option from the CIMPLICITY main installation. To 
install the FirstPAGE Server on your paging server select the "Pager" 
option from the CIMPLICITY main installation. Then choose "Server 
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Install with Remote FirstPAGE Server" when prompted, entering the 
location of the Server. 

It is best to install and configure your paging server first, then install and 
configure CIMPager, as you will be prompted for the location of your 
FirstPAGE Server during the install. Detailed instructions on how to 
install and configure your FirstPAGE Server can be found in the 
"FirstPAGE Pager Administrator User Guide". 
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Administrator Install 

The Administrator installation is for sites that have one or more 
CIMPLICITY server that they want to administer remotely. This requires 
the installation of CIMPager – Server on each of the CIMPLICITY 
servers.  (Refer to Local Server Installation or Remote Server 
Installation)  

Once the CIMPager – Server is installed and operational, you may install 
the CIMPager Administrator on any network workstation to enable the 
remote management of CIMPager alarms. 

CIMPLICITY Pager - Administrator Install

FirstPAGE Paging Server

CIMPLICITY HMI Server
CIMPLICITY Pager - Server

CIMPLICITY HMI Server
CIMPLICITY Pager - Server

CIMPLICITY HMI Server
CIMPLICITY Pager - Server

CIMPLICITY Pager -
Administrator
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C h a p t e r  T h r e e  

FirstPAGE PAGING SERVER DATA FILE 
CONVERSION 

� Once your project is upgraded it will not be usable on an older version of 
pager.  Therefore we recommend backing up your projects and pager 
database before applying this update. 

 

1. Stop all CIMPLICITY Projects. 

2. Backup CIMPLICITY\HMI\PAGER directory. 

3. Backup any CIMPLICITY projects. 

4. Run appropriate installation package. 

5. Copy all data files to the new Pager directory:  GE Fanuc\Proficy 
CIMPLICITY\Pager\Data 

6. From Windows Control Panel, Services, stop FirstPAGE Server Service 
and set Startup to Disabled. 

7. Reboot computer. 

8. From the Start\Programs\Proficy HMI Scada – CIMPLICITY 6.2\Pager, 
run the Database Conversion to convert FirstPAGE Server V7 files to 
the new FirstPAGE V8 format.  

9. Set FirstPAGE Server Service Startup to Automatic. 

10. Start FirstPAGE Server Service. 

11. Startup CIMPLICITY. 

12. Restart CIMPLICITY Projects and test CIMPager operation. 
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Starting CIMPager 

After the Administrator has been configured with device, provider and 
destination details you may now start to configure alarms in CIMPager. 

To start CIMPager: 

From your project’s Workbench, select the Pager folder, then select 
Alarms. The first time you start CIMPager the following screen 
appears: 

CIMPager - 

Configuration 

 

 

� See your FirstPAGE Server Installation and Usage Guide for 
information on configuring your Administrator details.  These 
details must be completed before proceeding to the configuration of 
CIMPager. 
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C h a p t e r  F o u r  

CONFIGURING CIMPAGER 

Before you can begin using CIMPager, you must confirm the correct 
location of your FirstPAGE Server and Port.   

This chapter contains information regarding the setup, configuration and 
maintenance of CIMPager. 
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Configuring CIMPager: 

1. Select the Options button in the toolbar.  The following screen is 
displayed:   

CIMPager 

Options 

 

2. Select the Name of your FirstPAGE Server.  This can be the machine 
name or IP address where your FirstPAGE Server is located. 

3. Port defaults to 8003. 

4. Select the desired Time Interval between pages.  Options are Seconds 
or Minutes.   

5. Click the OK button to save your Options. 
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C h a p t e r  F i v e  

USING CIMPAGER 

This chapter contains procedural information about using CIMPager.   
It begins with an overview of the functionality of the Alarm option and 
concludes with procedural information about performing everyday tasks. 



NETCON Technologies 

24 

Creating and Modifying Alarm Pager Entries 

Adding an Alarm Pager Entry 

The CIMPager - Configuration window will display the following: 

Alarm ID: The Alarm ID of the alarm that has pager actions 
defined. 

Alarm Class: The Alarm Class to be matched for that alarm. 

Resource ID: The Resource ID to be matched for that Alarm ID and 
Alarm Class. 

Escalation Scheme: The escalation scheme assigned to this pager 
action. 

Recipients:  A “+” separated list of recipients and their escalation 
levels in []. 

� Alarm ID initially sorts the list of pager actions. Click on any of the other 
title buttons at the top of the list to sort by that attribute. 

 

To add an alarm pager entry: 

1. Select the Alarm Pager Entries tab.  The following screen is 
displayed:   
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CIMPager 

Configuration 

 

2. Click New button from the toolbar or select New Entry from the 
File menu.   

3. The following screen is displayed: 

 Alarm Pager 

Entries 

 

4. Enter the name of the Alarm ID, Alarm Class, and Resource ID to 
create an alarm action for and click OK.    

5. Clicking the Browse button will populate the list boxes on the 
bottom of the form.  Select the Alarm ID, Alarm Class and Resource 
ID to monitor. 
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The following wildcards can be used in any of the three fields: 

* Search for any number of characters at this point in the string.   
For example: To create an entry for all alarm ID’s starting with 
“M” and ending with "X", enter M*X in the Alarm ID field. 

? Search for any character in this place in the string.   
For example: To create an entry for any resource ID’s that are 
three characters long, and whose first character is "M" and third 
character is "X", enter M?X in the Alarm ID field. 

 

� There are no implied wildcards.  If you do not include or 
terminate your search string with an asterisk, only those items 
that match your request exactly will be returned. 

6. Once the correct alarm has been selected, click the OK button.  The 
following screen is displayed: 

Edit Pager 

Entries 
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Editing Pager Entries 

You may now begin to configure the alarm details, including the 
pager recipient(s) and escalation level(s) for these destinations.   

The following defines the various fields available for pager entries: 

Pager Display: Defines what the pager message will look like: 

FIELD DESCRIPTION DEFAULT 

Message for 
escalation level 

Select escalation level for message. Level 1 

Same display for 
every escalation level 

Select to display same message for 
every escalation level. 

Selected 

Message prefix Entry field for personalized message to 
appear before default display. 

Empty Field 

Display alarm text on 
pager 

Select to display default message for 
Alarm ID. 

Selected 

Message suffix Entry field for personalized message to 
appear after default display. 

Empty Field 

 

Clear States: Defines what states will cause the alarm to be cleared and stop 

sending pages for the alarm: 

FIELD DESCRIPTION DEFAULT 
Acknowledge Select to stop sending pages for 

acknowledged alarms. 
Not Selected 

Reset Select to stop sending pages for alarms 
returned to normal state. 

Not Selected 

Delete Select to stop sending pages for deleted 
alarms because the problem is fixed. 

Selected 

 

Escalation Queue Timing: Specifies which escalation template will be 

applied. 

FIELD DESCRIPTION DEFAULT 
Scheme Drop down list with containing defined 

schemes. 
DEFAULT 

Edit Click to edit existing scheme. N/A 

New Click to enter a new scheme. N/A 
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Pager Recipients: Specifies who will receive the alarms: 

FIELD DESCRIPTION DEFAULT 
Available 
recipients 

List of available recipients to receive alarms – 
individual pagers or distribution lists. 

N/A 

Available 
recipients 

List of available recipients to receive alarms – 
individual pagers or distribution lists. 

N/A 

Add -> Highlight pager name in Available recipient’s 
list box and click Add button to select pager 
and place in right list box. 

N/A 

<- Remove Highlight pager from right list box and click on 
Remove button to remove pager from the 
Pager recipient’s list box. 

N/A 

- Highlight pager’s name in the right hand list 
box and click ‘-‘ to decrease the escalation 
level of the recipient. 

N/A 

+ Highlight pager’s name in the right hand list 
box and click ‘+‘ to increase the escalation 
level of the recipient. 

N/A 

 

� Click the Add button if you wish to add more alarms to this entry.  
This speeds configuration if the alarms have the same attributes. 

Once the pager entry has been configured, click the Update button in 
the toolbar or select the Update Now option from the File menu. 
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Viewing and Modifying a Pager Action 

To view or modify pager actions: 

1. On the Alarm Pager Entries tab, select an alarm from the list and 
click the Modify icon in the toolbar or select the Modify option from 
the Edit menu. 

Viewing or 

modifying 

Pager Entries 

 

2. The Edit Pager Entries dialog box will open.  The properties contain 
the current configuration information for the selected alarm.  
Modifications can be made on any of these properties. 

3. Click OK to close the Edit Pager Entries dialog box and modify the 
information for the selected alarm. 

4. Click Cancel to close the Edit Pager Entries dialog box without 
modifying the alarm. 
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Deleting a Pager Action 

To delete a pager actions: 

1. On the Alarm Pager Entries tab, select an alarm from the list and 
click the Delete icon in the toolbar or select the Delete option from 
the Edit menu. 

2. The Delete Selected Records dialog box will open. 

Delete Selected 

Records 

 

3. Click Yes to close the dialog box and delete the selected pager 
action.  The list of alarms on the CIMPager - Configuration window 
will automatically update. 

4. Click No to close the dialog box without deleting the selected pager 
action.  

5. Click Cancel to close the dialog box without deleting the selected 
pager action. 
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C h a p t e r  S i x  

ESCALATION SCHEMES 

Escalation Schemes are created to determine the following: 

• Escalation levels 

• How long to wait to send a page after an alarm has been set 

• How many pages to send for the escalation level 

• The time interval between each page 

Adding an Escalation Scheme 

To add an escalation scheme: 

1. Click on the New button under the Escalation Queue Timing area 
from the Edit Pager Entries window.   

The following screen will be displayed:  

Edit Escalation 

Queue 

 

 

2. Enter a name for the Escalation Scheme. 

3. Escalation level: defaults to 1. 
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4. Send level 1 pages: Select the radio button to set an initial delay 
before starting to send pages once an alarm becomes active.  

5. Number of pages to send: Select a numeric value to determine the 
number of pages to send to the pagers assigned to this escalation 
level.  By entering 0 in this field, pages will be sent to this level until 
the alarm is cleared.   

6. Time between pages: Select a numeric value to represent the time in 
minutes/seconds determining the delay between pages. 

7. After the configuration of level 1, select escalation level 2 or higher.  
The screen changes to the following format: 

Edit Escalation 

Queue 

 

 

8. Select one of the two-radio buttons displayed.  The first radio-button 
arrives at a time limit determined from the previous escalation levels 
selected.   

E.g. Escalation level 1 begins paging after 0 minutes, sends out 5 
pages every five minutes, which equals a 25 minute total.  Therefore, 
after 25 minutes, escalation 2 will begin paging, if the first radio-
button is selected.  

9. The second radio-button allows the manual time set for the 
escalation level selected to be set. 
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10. The number of pages to send and the time between pages feature are 
the same as the items displayed when configuring a first level 
escalation. 

11. There is a default escalation scheme, called DEFAULT, which 
provides the following escalation: 

 

Level Initial Delay Page Count Page Delay 
1 0 5 5 

2 25   (After Level 1) 5 5 

3 50   (After Level 2) 5 5 

4 75   (After Level 3) 5 5 

5 100  (After Level 4) 5 5 

 

The initial delays for the DEFAULT scheme are determined as in the 
Example above. 

The default scheme can be altered. Schemes are unique to each 
project, so modifying scheme parameters in one project will not 
modify the schemes of the same name in another project. 

 

Modifying Message Interval 

You may set the interval between pages to use minutes rather than 
seconds.   

� See Chapter 4:  Configuring CIMPager for details on changing 
CIMPager Options and setting this message interval. 

 

The Escalation Queue screen will then display all options in minutes: 
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Edit Message 

interval 

 

 



CIMPager v8.0 

35 

Viewing Modifying an Escalation Scheme 

To view or modify an escalation scheme: 

1. Click the Edit button on the Edit Pager Entries screen under the 
Escalation Queue Timing area of the form. 

 

The following screen will be displayed:  

Edit Escalation 

Queue 

 

2. The Edit Escalation Queue dialog opens.  The properties contain the 
current configuration information for the selected scheme.  
Modifications can be made on any of these properties. 

3. Click OK to close the Edit Escalation Queue dialog box and modify 
the information for the selected scheme. 

4. Click Cancel to close the Edit Escalation Queue dialog box without 
modifying the scheme. 
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C h a p t e r  S e v e n  

VIEWING ALARMS BY RECIPIENT 

CIMPager allows you to quickly view the alarms that recipients or 
distribution lists are members of.   

To view alarms by recipient: 

1. Click the Alarms by Recipient tab from the Pager Configuration 
screen or select Alarms by Recipient from the View menu. 

The following screen is displayed: 

Recipient 

Alarms 

 

2. Selecting a User or Distribution List from the drop-down will display 
a list of associated alarms for which this pager is configured.  

3. If a user is selected, all alarms associated with distribution lists for 
which this user is a member will also be displayed. 

4. The Disable pages to user checkbox will disable any pages 
associated with this user. The association will not be broken but no 
pages will be sent in the event of these alarms becoming active. 
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C h a p t e r  E i g h t  

DISTRIBUTION LISTS 

CIMPager allows you to send messages to both CIMPager distribution 
lists and distribution lists that have been created in FirstPAGE 
Administrator. 

Adding a Distribution List 

Creating a new distribution list: 

1. Click the Distribution Lists tab from the Pager Configuration screen 
or select Distribution Lists from the View menu. 

The following screen is displayed: 

Distribution 

Lists 

 

2. Click New button on the toolbar or select New Entry from the File 
menu. 

3. You will be prompted to enter in the Distribution List name. 
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New 

Distribution 

List 

 

 

4. Click OK.  The following screen will be displayed: 

Creating a 

Distribution 

List 

 

 

5. The new distribution list will be listed in the Distribution list drop 
down box. 

6. Add or remove pagers to/from the distribution list by using the Add 
or Remove buttons. 

� Distribution lists are local to each project. 

� When adding a distribution list as a recipient to a pager entry, all 
distribution lists created in CIMPager display with @ in front of 
them and all those created in FirstPAGE Administrator will 
display with $ in front of them. 
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Viewing and Modifying Distribution Lists 

To view or modify distribution lists: 

1. Click the Distribution Lists tab from the Pager Configuration screen 
or select Distribution Lists from the View menu. 

2. Select the distribution list you wish to modify using the Distribution 
List drop down menu. 

3. Add or remove pagers to/from the distribution list by using the Add 
or Remove buttons.   All changes are immediate. 
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C h a p t e r  N i n e  

Running Database Converter  

The CIMPager Server comes equipped with a database converter that 
allows the administrator to upgrade a database if they are running an 
older version of CIMPager Server. 
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Upgrading the Database  

If upgrading from a previous version of CIMPager Server, the 
administrator and server databases must both be converted to run with 
the new version. 

Running the Convert Option 

1. From the Start menu, select Programs – FirstPAGE – Server – 
Database Conversion. This will launch the Conversion Wizard. 

Database 

Conversion 

Wizard 

 

2. Be sure to stop the FirstPAGE Server service via Control Panel 
before running the database conversion. 

3. Select the correct time zone that each destination will use, then click 
Next. 
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Database 

Conversion 

Wizard 

 

4. For users who are running versions prior to Version 8, the Converter 
Wizard will run this upgrade first, converting .DAT files to .MDB 
(Access Database). For Version 8 users, the Wizard will indicate 
source data path is invalid, as Version 8 does not utilize .DAT files. 
Selecting Close on this screen will launch the conversion for Access 
Database upgrade. 
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Database 

Conversion 

Wizard 

 

5. The Conversion Wizard will display a summary of changes that will 
be made to your FirstPAGE Server database, including the current 
version that is running and the target database. 
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Database 

Conversion 

Wizard 

 

6. Click Start to run the converter. Conversion results will then be 
displayed. 

Database 

Conversion 

Wizard 
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C h a p t e r  T e n  

Technical Assistance 

FAQ 

 
Every NETCON product contains a FAQ file specific to that product. You can view 
this FAQ file by visiting the NETCON web site (www.netcontech.com) and browse 
the product page for the product you are using. 
 

Support Contracts 

You may purchase a support contract for FirstPAGE Server. Various levels of 
support are available. View the NETCON web site (www.netcontech.com) and 
browse the product page for product you are using. 
 
For all support related issues, please provide the version of the software that you are 
running.  This may be verified by browsing your Start menu, Programs, then 
selecting the application in question (ie. CIMPLICITY\Pager), then selecting Version 
Info.  This will provide the install kit version that is currently running. 
 

Help Desk   

To reach our help desk please use one of the following methods: 
 

Telephone: +1.519.652.0401 
Fax: +1.519.652.9275 
Web: www.netcontech.com - Customer Care 
E-Mail: support@netcontech.com 

 
Please have your version information and support contract ready before calling or 
include it in your correspondence. Support is free for product trials and for the first 
30 days of product ownership. To view your product version select Start – Programs 
–CIMPLICITY  – Pager - Version Info. 
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Glossary 

Distribution List 

Lists containing a group of pagers to contact.  When selecting a distribution list all of 
the pagers within that list will have a page sent to them. 

 

Escalation Level 

The order in which pages will be sent. 

 

Escalation Scheme 

Information put together to determine when to sent out alarm pages. 

 

Recipient 

Pagers designated to receive alarm messages. 

 


